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[bookmark: _Toc524324937][bookmark: _Toc524324977][bookmark: _Toc524325053][bookmark: _Toc524325191][bookmark: _Toc79998087]INSTRUCTIONS FOR SUBMISSION OF INITIAL AND FOLLOW-UP Serious Adverse Event FORMS (WORD VERSION) 
Please read before completing the Form

Please Note: The investigator at the accruing Lead Academic Organization (LAO) or Affiliated Organization (AO) needs to sign and date the form for each initial and all follow-up report(s). 

Initial Event Report:
1. Open the blank Serious Adverse Event Report Form (Word version), and save as the Initial Event Report file. The file name must be in the following format, including the DCP Protocol Number, Participant Identification (PID) #, event term, and date the form was completed in the file name (e.g. DCPProtocol#_ PID_1234_Pancreatitis_Initial_20180225).
2. Under the Review tab, click the Track Changes drop-down menu and ensure Track Changes is not highlighted.
3. Please update the form header to include NCI Protocol/Grant No., IRB Protocol No., and PID #.  as outlined below. 
4. Fill out the Serious Adverse Event Report Form Word document. This is the “Initial Event Report”. 
Note: Users with Microsoft Office Word for Mac complete all fields as described above. To mark checkbox fields, please highlight the checkbox with your cursor and press the space bar.
5. To fill out each field, click on the grayed-out text and start typing. This will replace the grayed-out text with the information that you wish to enter. Please make sure to check the Initial Event Report checkbox in Section B. 
6. Complete all fields in required Sections A‒E and G using the instructions below. When additional space is needed to complete a field, please use the continuation pages (Section G).
7. Once all data fields are complete, save and print the complete Initial Event Report Word document. 
8. Using a handwritten (“wet”) or electronic signature, the investigator signs on the appropriate signature line in Section B. 
9. Scan the completed and signed Initial Event Report document. 
Note: Please make sure that the Initial Event Report is clean, without mark-up, comments, etc. Handwritten data entry is not accepted.
10. Email the scanned, signed Initial Event Report to the DCP Medical Monitor, Protocol Principal Investigator (PI), LAO, DCP Regulatory Contractor’s Safety Department (safety@ccsainc.com) and any other recipients as stated in the protocol (e.g., pharmaceutical partner). For Cross-Network Trials (CNTs), also email the signed Initial Event Report to the Lead and Collaborating LAO Coordinators.

Follow-up Event Report #1:
1. To respond to queries or provide new information, create a follow-up report. To do so, open the “Initial Event Report” (Word document) for this serious adverse event (SAE). 
a. Under the File tab, click on Save As and save as the Follow-up Event Report file. The file name must be in the following format, including the DCP Protocol Number, PID #, event term, follow-up, the number of the follow-up, and the date that the form was completed (e.g., DCPProtocol#_PID_1234_Pancreatitis_Follow-up1_20180225).
b. Under the Review tab, click the Track Changes drop-down menu and choose Track Changes.
c. Make sure that “All Markup” is selected.
2. In Section B, Event Information, uncheck ‘Initial Event Report’ and check ‘Follow-up Event Report’ and add #1 to Follow-Up No.”  The “Initial Event Report” text will then appear with a strikethrough to indicate a change; additions will appear as underlined text. 
3. Make all applicable additions and/or changes to the Report. To do so, click the field that you wish to change and type the revised information. 
4. Once complete, save the file. 
5. Print out the Follow-up Event Report showing all tracked changes. 
6. Sign and date the document by hand on the appropriate signature lines as described above.
7. Scan the document.
8. Email the scanned, signed Follow-up Event Report to the DCP Medical Monitor, Protocol PI, LAO, DCP Regulatory Contractor’s Safety Department (safety@ccsainc.com) and any other recipients as stated in the protocol (e.g., pharmaceutical partner). For CNTs, also email the signed Follow-up Event Report to the Lead and Collaborating LAO Coordinators.

Follow-up Event Report #2, etc.:
Repeat the steps above under Follow-up Event Report #1 for all additional SAE follow-up reports with the following exceptions:
1. Before beginning to type any changes and/or new information (between 1a and 1b), make sure all prior changes have been accepted. To do so, click on the Accept drop down list under the Review tab and select “Accept All Changes”.
2. In Section B, Event Information, change the number of the follow-up to #2 or higher, as appropriate.
Technical Note: 
When using the TAB key to navigate between fields, please click on the grayed-out text field before pressing TAB to navigate to the next field on the form. 
The TAB key cannot be used to navigate between fields in separate sections. Please use the mouse or use the Go To Function to navigate between sections A-E and G of the Serious Adverse Event Report Form
[bookmark: bmgetidfrompartner][bookmark: bmcreateid]

INSTRUCTIONS FOR Completion OF INITIAL AND FOLLOW UP Serious Adverse Event REPORT FORMS

Header Information

DCP Protocol/NCI Grant No.:	Enter the DCP-assigned protocol or NCI grant number for the trial in which the participant is registered (e.g., UAZ20-01-01; UAZ2015-00-01, P50-CA-58186). Note: The protocol number assigned by DCP is found on the cover page of the protocol and may be the same as or different from the local protocol number. 

IRB Protocol No.:	Enter the Central IRB (CIRB)-assigned protocol number (e.g., AAAB0407). Note that this may be the same as the DCP protocol number.


REQUIRED FIELDS ON ALL REPORTS

Today’s Date:	Enter the date this report was completed using the MM/DD/YYYY format. 

Sponsor:				This field is prefilled with NCI, DCP as funding and/or IND 						sponsor.

Study (Indication):			Enter the protocol title as it appears on the protocol document.

Drug(s) Under Investigation: 	Enter the drug(s) being investigated in the study (e.g., erlotinib).

IND No.:	Enter the IND number under which the protocol was submitted. This information is found on the cover page of the protocol. If the study is not being done under an IND (e.g., exempted from the IND requirement), enter “not applicable”.


[bookmark: _Toc79998095]A. STUDY PARTICIPANT INFORMATION 

[bookmark: _Toc79998089]Study Participant # or PID #:	Enter the identification code that uniquely identifies the participant to the protocol. 

Year of Birth:	Enter the study participant’s year of birth using the YYYY format.

Weight at Time of Event:	Enter the participant’s weight at the time of the event or at the last evaluation visit, using English or metric measurement. 

If weight was not obtained, mark “not available”.

Height at Time of Event:	Provide the participant’s height at the time of the event or at the last evaluation visit, using English or metric measurement.

If height was not obtained, mark “not available”.

Gender (mark one):			Mark the gender of the participant. 

Race:	Using the pulldown menu, select one or more of the following standard NIH race categories (note that there is no ‘Other’ category):
· American Indian or Alaskan Native (A person having origins in any of the original peoples of North, South, or Central America who maintains tribal affiliation or community attachment).
· Asian (A person having origins in any of the original peoples of the Far East, Southeast Asia, or the Indian subcontinent, including, for example, Cambodia, China, India, Japan, Korea, Malaysia, Pakistan, the Philippine Islands, Thailand, and Vietnam).
· Black or African-American (A person having origins in any of the black racial groups of Africa).
· Native Hawaiian or Other Pacific Islander (A person having origins in any of the original peoples of Hawaii, Guam, Samoa, or other Pacific Islands).
· Not Reported (Race is not reported).
· Unknown (Race is unknown).
· White (A person having origins in any of the original peoples of Europe, the Middle East, or North Africa).

Ethnicity: 	Using the pulldown menu, select one of the following standard NIH ethnicity categories:
· Hispanic or Latino (A person of Cuban, Mexican, Puerto Rican, South or Central American, or other Spanish culture or origin, regardless of race).
· Not Hispanic or Latino (A person NOT meeting the definition for Hispanic or Latino).
· Unknown (Ethnicity is unknown).
· Not Reported (Ethnicity is not reported).

B. EVENT INFORMATION

[bookmark: _Toc79998096]Event Report Type:	Use this section to indicate if this is an initial report or a follow-up to a previously submitted report.

If this is the first time the report has been submitted to DCP, mark “Initial Event Report”. 

If a previous report was submitted to DCP for the same event and new, updated, or corrected information is being provided, mark “Follow-up Report” and enter the consecutive number of the follow-up report. For example, if the report is a follow-up to the initial report, it should be indicated as Follow-up Report #1. If the report is a follow-up to Follow-up Report #1, it would be Follow‑up Report #2.

Event Onset Date:	Enter the date the outcome of the event fulfilled one of the serious criteria (which may not be the same date as the onset of the event itself), using the MM/DD/YYYY format. If the actual date is unknown, enter the month and the year but use “UNK” for DD. 

Event Approx. Time:	Enter the time of the event onset, using 12-hour time format. Specify AM or PM. Enter “UNK” if the time is not known.

[bookmark: _Toc79998110]Event Occurred at:	Enter the place where the event occurred. For example, if the event occurred at the participant’s home or at another location, enter this information. If the location at which the event occurred is not known, enter “UNK”. 

Duration of Drug Exposure 		Enter number of days or months the participant had been on
at Event:		study drug at the time of the event or, if off treatment, the length of time on intervention plus the length of time since the last dose. Provide as much detail as possible.   

[bookmark: _Toc79998097]Primary Event (diagnosis):	List only one primary event per form. Enter a symptom, sign or condition/diagnosis (if available) as the primary event. If a condition/diagnosis has not been identified, enter the symptom (e.g., chest pain). The verbatim term reported by the participant should be used whenever possible or appropriate. Update the symptom to the condition/diagnosis on a follow-up form when available (e.g., coronary artery disease). It is also appropriate for the investigator/co-investigator to report an accepted medical term in this field (e.g., clinically significant change in laboratory value, disorder, or procedure) as needed, but care should be taken to retain the character and nature of the clinical complaint. Definitions for reporting of selected adverse events for regulatory purposes can be found at.  https://cioms.ch/wp-content/uploads/2017/01/reporting_adverse_drug.pdf.

	Please note that death is an outcome, not an event. The cause of death should be reported as the event. If the cause is unknown, “death, cause unknown” can be entered as the event. When identified, the cause of death should be entered as the event on a follow-up form, with supporting documentation if available (e.g., death certificate, autopsy report).

	Secondary events occurring in the same time frame as the primary event (e.g., headache in a participant hospitalized to rule out myocardial infarction) that do not fulfill one of the serious outcome criteria can be discussed in the Describe Event field. If a secondary event fulfills one of the serious outcome criteria, submit it on a separate Serious Adverse Event Report Form. An example is a participant hospitalized for surgical treatment of prostate cancer (serious adverse event [SAE] #1) who also experienced post-surgical bleeding that resulted in prolongation of hospitalization (SAE #2).

Primary Treatment	Enter the time when primary treatment was given to the 
Approximate Time:	participant, using the 12-hour time format. Specify AM or PM. Enter “UNK” if the time is not known.

Primary Treatment of Event:	Describe interventions specific to the event, including medications administered (including dose, units, frequency, and route), procedures the participant has undergone, and any other pertinent information. Utilize sources such as the participant’s medical record or hospital progress notes to complete this section. 

Attending Physician (Name): 	Enter name, phone number, fax number, hospital or clinic’s name, and address of the physician who treated the participant.

Describe Event:		The description should support the symptom, or diagnosis listed as the primary event term, including a brief chronology with dates and additional details of diagnosis and treatment. Use the continuation section on page 5 if more room is needed to Describe Event. Medical records and other documentation sent to the DCP Regulatory Contractor’s Safety Department with the Serious Adverse Event Report Form are supplemental to the description and are not acceptable as a replacement for a clear description. Also, avoid use of abbreviations and try not to duplicate information that is captured elsewhere on the Serious Adverse Event Report Form. If the participant was hospitalized, include the discharge date and forward the discharge summary with the report.

Form Completed By: 	Print name and title of person completing the form.

Investigator or
Co-Investigator Signature:	The form must be signed by the accruing LAO or AO investigator or co-investigator as documentation that he/she has reviewed and approved the information being reported. Enter the date the investigator or co-investigator signed the form and provide the contact phone number for the investigator, co-investigator or coordinator. Follow-up reports must be re-signed and dated by the investigator or co-investigator. 

C. SITE INFORMATION	

Investigator or
Co-Investigator Name: 	Enter the accruing LAO or AO investigator’s/co-investigator’s name.

Address:	Enter the name and address of the LAO or AO where the participant enrolled in the study.
[bookmark: _Toc79998129]
D. SUSPECT MEDICATION(S)

Study Design:	Mark the box for “Blind” if the study is blinded; mark the “Open/Unblind” box for an open and/or unblinded study.

Possible Dose:	Indicate the dose of the agent/placebo the participant was taking at the time of the SAE.

Indicate the units of the agent dose (e.g., mg) as administered under the protocol. 
[bookmark: _Toc79998136]
Frequency:	Provide the frequency at which the agent is administered under the protocol (e.g., qd).

[bookmark: _Toc79998137]Route:					Indicate the route of administration of the agent (e.g., po).

Study Drug: 	Enter the name of the agent the participant is receiving as part of the protocol. 

If the study is blinded, enter the name of the agent vs. placebo. (e.g., atorvastatin vs. placebo). 

If more than one agent is utilized for the protocol, indicate each agent name. 

Formulation:	Indicate the formulation of the study drug, e.g., tablet, solution, etc.

[bookmark: _Toc79998138]Lot No. (if known):	If available, indicate the most recent lot number for the agent administered. Enter “UNK” if the lot number is not available. 
	
Start Date of Study Drug:	Enter the date the agent was first administered to the participant on the protocol, using MM/DD/YYYY format.

[bookmark: _Toc79998114]Was Blind Broken Due to Event?:	If appropriate, indicate if the blind was broken due to the SAE. If not applicable, mark “NA”.

Was Study Drug Stopped/ 	Indicate if the study drug was stopped, interrupted, or dose 
Interrupted/Reduced in 	reduced due to the SAE. 
Response to Event?:
	If yes, complete items a–e:
a) If stopped, specify the date study drug was last taken. Report the date in the MM/DD/YYYY format, or mark “NA” if the drug was not stopped.
b) Report the new dose of agent if lowered in response to the event, or mark “NA” if the dose was not reduced. Also specify the date that the dose was reduced using the MM/DD/YYYY format.
c) If interrupted, specify the total number of days the dose was skipped. Mark “NA” if the dose was not interrupted.
d) Did the event abate after study drug was stopped or dose reduced? Mark “NA”, “Yes”, or “No”. This assists the Medical Monitor in assessment of the relationship of the event to study drug.
e) Did the event reappear after study drug was reintroduced? Mark “NA”, “Yes”, or “No”. This assists the Medical Monitor in assessment of the relationship of the event to study drug.

[bookmark: _Toc79998142]Was Patient Taking any Other 	Indicate whether or not participant was taking other concomitant 
Medications Concomitantly	medications at the time of the event by marking “Yes” or “No”. 
at the Time of the Event?:	If Yes is marked, further information on the concomitant medication is required in the fields below. Use the continuation page in Section G if more room is needed. Do not list drugs used to treat the event. If the participant was not taking any concomitant medications at the time of the event, proceed to the next section of the form.

Drug Name:	Provide the name of the concomitant medication. If the brand name drug was taken, record it in this field. If a generic formulation was taken, record the name in this field. 

Enter only one medication per line. In the case of combination medications such as Bactrim, do not record the individual medications (sulfamethoxazole and trimethoprim) that make up the combination on separate lines. 

Dose:	Under Units, record the dose with units (e.g., 100 mg) of the medication. For combination medications, record units as tablets, capsules, tablespoons, etc.

	Under Frequency, provide the regimen at which the medication was last administered (e.g., qd, bid). 

Route:					Indicate the route of administration for the medication. 

Indication for Use:	Indicate the reason the medication is being taken (e.g., condition/diagnosis). These reasons should be reconciled with the section on “Relevant Medical History".

[bookmark: _Toc79998147]Start Date:	Indicate the date the participant began taking the medication in the MM/DD/YYYY format. If the exact date is unknown, indicate at least the year. Enter “UNK” if the month or day is unknown (e.g., UNK/UNK/2013).

[bookmark: _Toc79998148]Stop Date:	Record the date the participant stopped taking the medication in MM/DD/YYYY format in the left column. If the participant is still taking the medication, mark “X” in the right column to indicate this.
E. ADVERSE EVENT

[bookmark: _Toc79998128]Relevant Laboratory/ 	If diagnostic tests, including laboratory tests or imaging, relevant
Diagnostic Tests:	to the event were performed, provide the date the test was performed above “Month”, “Day”, and “Year”; the name of the test performed; and the results. For laboratory tests, provide the units with the results, as well as the local normal range. Use the continuation page in Section Gif more room is needed.

	If no diagnostic tests or laboratory tests were performed, mark “No tests performed” and continue to the next section of the form. 

[bookmark: _Toc79998126]Relevant Medical History, 	Enter information concerning participant’s relevant medical 
Including Pre-existing 	conditions and treatments either prior to or during the study
Conditions:	(e.g., hypertension, diabetes mellitus, renal or hepatic dysfunction), including any significant lifestyle factors and history (e.g., allergies, pregnancy history, smoking, alcohol use, drug abuse, etc.). Add the date, if known. Use a continuation page if more room is needed.

[bookmark: _Toc79998098]CTCAE Term and Version:	If a CTCAE term corresponding to the event is available, enter the term and the CTCAE version (designated in the protocol). If a CTCAE term corresponding to the event is not available in the version used, mark “NA” and enter “Other, specify” for the CTCAE term under an appropriate System Organ Class. If the latter is used, NCI, DCP will code the event directly using the appropriate medical dictionary (e.g., MedDRA). 

Grade:	Severity is a measure of the intensity of a specific event (e.g., grade 4); the event itself may be of minor medical significance (e.g., severe headache). Mark the numerical grade related to the CTCAE term that has the description best corresponding to the severity of the event. If an appropriate CTCAE term was not identified, refer to the protocol or CTCAE “Other, specify” for the general scale and mark the grade with the description corresponding to the severity of the event.

[bookmark: _Toc79998100]Why Serious?:	The criteria for identifying an SAE are based on an outcome or action associated with an event that poses a threat to a participant’s life or functioning. Mark the reason the event is considered serious by selecting one of the following:
Death.
A life-threatening event.
(The participant is, in the view of the investigator/co-investigator, at immediate risk of death from the reaction as it occurred [i.e., it does not include a reaction that, had it occurred in a more severe form, might have caused death].)
Inpatient hospitalization or prolongation of existing hospitalization.
(NCI, DCP uses admission or stay (including emergency room) equal to or greater than 24 hours as the definition of hospitalization. Exceptions are hospitalization for treatment of a pre-existing condition [unless the condition increased in severity on study], outpatient surgery, planned/elective procedures, and procedures described in the protocol [e.g., pharmacokinetic sampling, surgery] even if the hospital stay is of the described length; however, it does include events resulting from any of these that fulfill other serious outcome criteria, e.g., prolonged hospitalization or life-threatening. In contrast, an event occurring during any hospitalization, even during protocol-defined procedures, that prolongs the hospitalization or has another serious outcome should be considered an SAE and reported by the Investigator/Co-Investigator on the DCP Serious Adverse Event Report Form.) 
A persistent or significant incapacity or substantial disruption of the ability to conduct normal life functions.
A congenital anomaly/birth defect.
Important medical event, specify. Indicate the reason for selecting this outcome.
(Medical and scientific judgment should be exercised in deciding whether expedited reporting is appropriate in other situations, such as important medical events that may not be immediately life-threatening or result in death or require hospitalization but may jeopardize the participant or may require medical or surgical intervention to prevent one of the outcomes listed above.)
	
[bookmark: _Toc79998118]Outcome of Event 
(at time of report):			Enter the outcome of the event by marking ONE of the 
following:
“Resolved”—The adverse event ended.
· If resolved, please provide the resolution date in MM/DD/YYYY format.
“Improved”—The adverse event has not ended but is improving.
“Unchanged”—The adverse event is continuing at the same severity.
“Worse”—The adverse event worsened.
“Not Available”—Mark if the outcome of the SAE is currently unknown.
“Fatal”—The adverse event resulted in death.
· If fatal, enter the date of death in MM/DD/YYYY format.
· Cause of Death—Enter the reason for the participant’s death. 
· If the cause of death is not known at the time of the SAE report, enter “unknown”.
Autopsy performed—Mark “Y” for yes, “N” for no, or “unknown”.

Investigator’s/Co-Investigator’s 	Enter the investigator’s/co-investigator’s assessment of the 
Opinion of the Relationship		relationship between the event and the study agent by selecting 
between the Event			one of the following elements:
and the Study Drug:			
“Definite”: 
· Event with plausible time relationship to drug intake.
· Cannot be explained by disease or other drugs.
· Response to withdrawal plausible (pharmacologically, pathologically).
· Re-challenge satisfactory, if necessary.

“Probable”:
· Event with reasonable time relationship to drug intake.
· Unlikely to be attributed to disease or other drugs.
· Response to withdrawal clinically reasonable.
· Re-challenge not required.

“Possible”: 
· Event with reasonable time relationship to drug intake.
· Could also be explained by disease or other drugs.
· Information on drug withdrawal may be lacking or unclear.

“Unlikely”: 
· Event with an improbable (but not impossible) relationship to drug intake.
· Disease or other drugs provide plausible explanations.

“Unrelated”: 
· No identifiable relationship of event to investigational agent or study participation. 

[bookmark: _Hlk89698726]Was This Event Reported		Check the appropriate boxes to indicate all other entities that the 
[bookmark: _Hlk89698633]by the Investigator or 		SAE was reported to (CIRB, local IRB as applicable, other 
Co-Investigator?				investigators participating in the study). If “Other Investigators 
[bookmark: _Hlk89698833](Check all that apply): 		Participating in the Study” has been checked, please list the names of the investigators and their study sites.  


F. Comments/Clarifications

This section is for the use of the NCI, DCP Medical Monitor, and should be left blank by the reporting institution.

G. Continued Information
This section should be used to include any relevant information that does not fit in the space provided in the main body of the form. Pages specifically formatted to continue entry of concomitant medications from Section D and relevant laboratory/diagnostic tests from Section E are provided. Continuation pages for other sections or fields (e.g., event description in Section B) can be appended.  
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